OKLAHOMA

ahoma Publisher s

Vol. 95 No. 8 16 Pages ¢ August 2024 www.OkPress.com www.Facebook.com/okpress

OPA hosts NAM
members in OKC

The 101st Annual Summer
Conference of Newspaper
Association Managers (NAM)
was held July 30-August 2 in
Oklahoma City.

Press association managers
from 32 states were represent-
ed at the meeting hosted by
the Oklahoma Press Associ-
ation.

In addition to the unique
opportunity to discuss com-
mon issues, managers had the
opportunity to explore parts of
Oklahoma City.

The group stayed at the
historic Hilton Skirvin Hotel
in downtown Oklahoma City.

Events included a visit to
the Oklahoma City National
Memorial, dinner and tour
at the National Cowboy and
Western Heritage Museum,
and a visit to the Oklahoma
Press Association office.

“This was truly a NAM
conference to remember. And
it set the bar quite high for
our future events,” said Layne
Bruce, executive director of
the Mississippi Association
and NAM Clerk.

Mark Thomas, executive
vice president of the Oklaho-
ma Press Association, said, “It
was an honor to host NAM in
Oklahoma City. We learn how
to create value for members
and navigate difficult times
together.”
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Members of Newspaper Association Managers pose in front of The End of the Trail statue at the National Cowboy & Western
Heritage Museum. The group met in Oklahoma City for their 101st Annual Summer Conference.
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From the President

By Shauna Belyeu
Publisher of the Eufaula Indian Journal  OPA President 2024-2025

The end of summer was
rapidly approaching, and I
realized that if I was going
to find time to break away,

I had found the one perfect
week. The move to the new
office was complete, we were
between special sections and
all employees were accounted
for.

I planned on extending a
day on either end of the week-
end and could still be back to
help get the next papers out.
My daughter and I were off
for a mini vacation. The plan
was to totally unplug. For any
of you newspaper folk, you
know how hard that can be.
You have to resist the urge to
take a quick peek even though
everything was crossed off the

list and all plans were in place.

By the second day, it got
easier to leave that phone
alone.

My blood pressure and cor-
tisol levels began to drop.

I had no idea what time
was, and it mattered less and
less.

It was a nice little getaway,
until it wasn’t.

We flew back to the Atlanta
airport, loaded on the Plane
Train and began to hear the
scuttlebutt about canceled
flights and stranded passen-
gers. Unbeknownst to us, the
“largest IT outage in history”
caused by a flawed software
update had affected airports
around the world.

The blue screen of death
was the sure sign of techno-
logical failure. We were now
victims of the CrowdStrike
chaos that struck the day we
landed for our vacation, and
we were blissfully unaware.

Planes, trains and rented automobiles

Delta was one of the hard-
est hit, scrubbing 1,700 flights
as we were traveling home
that Sunday.

There were more than
4,000 flight cancellations and
35,500 flight delays world-
wide, according to flight
tracking.

The lines coiled through
the main terminal as angry
passengers tried to rebook a
flight that wouldn’t take off
for another three days.

We visited with so many
people who had been stranded
at the airport.

One was an 87-year-old
veteran who was trying to
board his Honor Flight before
it was canceled. Another was
a young mother who had a
baby in one hand and a three-
year-old in a stroller. She had
been stranded for three days.

We visited with a man
about to celebrate his 40th
birthday in Greece as a
surprise from his wife. The
surprise was on them both as
they shared a seat at our table
at the food court as we were
all trying to find any alterna-
tive flights. No comparison to
Greece, [ assure you.

I quickly realized that
we were late to this party as
the people who had already
been stranded in the airport
for three days before us were
priority to get a flight out.

We started looking for car
rentals and found one last car
available. It was a black Jeep.
I would have settled for an
orange Pinto at that point if
it could get us out of Atlanta
before the sun came up.

As we stood in line for the

car rental, I heard my favorite
story of all.

I was visiting with the lady
at the car rental desk about
having to get back to get the
paper out. The man behind me
asked which paper. I told him
Eufaula, Oklahoma.

“Oh, the Oklahoma Press
Association with Mark Thom-
as,” he said.

To my surprise, my last
conversation at the airport
would be the best.

I met a publisher from
Illinois. He said their press
association discusses the
OPA and how we set a high
standard. We all know that but
how exciting to hear it from
another state.

On my news hiatus, air-
ports shut down, a presiden-
tial candidate withdrew their
candidacy and a hydrothermal
explosion happened at Yellow-
stone National Park.

Equally as newsworthy is
the fact that Mark Thomas and
the Oklahoma Press Asso-
ciation are working hard to
protect our interests, promote
us all and are setting the
standard for press associations
nationwide.

Transportation could shut
down at any minute and we
might not know who the next
leader of the country will be,
but rest assured the Oklahoma
Press Association is work-
ing hard to protect our best
interests, promote the news
industry and do it in a manner
that sets the standard across
the country. That’s as exciting
as catching the last Jeep out of
Atlanta at midnight.

OPA CALENDAR
OF EVENTS

For more information
on upcoming events visit

okpress.com/events

Thur., September 12
DIGITAL MARKETING
FUNDAMENTALS:
ENHANCING YOUR
CLIENT’S ONLINE
PRESENCE

In this comprehensive webinar,
Michael Lewis will delve into
the core aspects of digital
marketing, providing valuable
insights and practical tips to
boost your client’s business
online presence.

Thur., September 26
NA WEBINAR: ADOBE
INDESIGN: FROM ZERO
TO HERO!

In this fast-paced session,

Kevin Slimp will take attendees
through the very basics to
advanced skills. Even beginners
will walk away from this class an
InDesign hero!

Thur., October 31
OKLAHOMA JOURNALISM
HALL OF FAME
NOMINATIONS DUE

The Oklahoma Journalism Hall
of Fame honors 9 to 12 indi-
viduals each year in the areas
of print, broadcast and online
journalism. Nominations must
be submitted for consideration
by the Hall of Fame’s selection
committee. Letters of support
from members of the community
and industry provide additional
weight to nominations.

Got News?

Share news about your newspaper
with other OPA members! If you have
a new hire, sales promotion, contest,
or have received an award or honor
tell us about it so we can put it in The
Oklahoma Publisher.

Send your news or story ideas to

aanderson@okpress.com
or call 405-499-0020




RWPG acquires Lewis Gounty Press

Reaves & Williams Publish-
ing Group (RWPG) recently
announced the acquisition of
Lewis County Press.

The sale includes two
Oklahoma newspapers — the
Blackwell Journal-Tribune and
The Marlow Review.

The company currently
owns newspapers and busi-
nesses in Tennessee, Kentucky,
Virginia, Missouri, Arkansas
and Oklahoma, as well as vari-
ous websites and podcasts.

RWPG is a family-run busi-
ness. At the helm are Clarissa
Reaves-Williams, who has
more than 35 years of media
experience, and her husband

Herbert Williams, who has
nearly 30 years of business
experience. The Williams’ son,
Cameron, serves as chief tech-
nology officer. Their daughter,
Bethany, will be the company’s
chief strategy officer. Serving
as chief financial officer is
Greg McNutt.

Clarissa and Herbert Wil-
liams believe that the most
important parts of a newspaper
are mirroring the community
it serves, being a watchdog
for the readers, and holding
the government accountable,
regardless of party affiliation.
Both have long tenures in
community involvement. They

also own Shine Messengers, a
Christian-based company, and
Cookeville Now, which in-
cludes a YouTube channel and
podcast dedicated to uplifting
content and community stories.
Reaves & Williams Pub-
lishing Group, headquartered
in Tennessee, is committed
to combining traditional print
media with cutting-edge digital
strategies, helping businesses
achieve their goals through in-
novative marketing strategies.
Its dedication to preserving the
integrity of local news while
embracing new technologies
sets a strong foundation for
future growth.

Absentee Shawnee News
has applied for Affiliate
News Media membership in
OPA. The newspaper, which
is owned by the Absentee
Shawnee Tribe, is printed 12
times per year and its website
is astribe.com.

The application was sub-
mitted by Mindy Longhorn,
media director for the tribe.
The business mailing address
is 219 E. Walnut, Tecumseh,

OPA receives membership application

OK 74873 and phone is 405-
598-1279.

Written protests to a
membership application must
be received at the OPA by
Sept. 10, 2024. Protests may
be emailed to OPA Executive
Vice President Mark Thomas
at mthomas@okpress.com
or mailed to Oklahoma Press
Association, 3601 N. Lincoln
Blvd., Oklahoma City, OK
73105.

Any current member
filing a written protest will
be entitled to be heard by the
Board of Directors at its next
scheduled meeting.
Information and applica-
tion forms for OPA’s mem-
bership classifications may
be found at okpress.com/
join. Lists of current members
may be found at okpress.com/
members.

You've Got Questions!

¢ Can | photograph minors without consent?
* Can police deny access to records by issuing a press release? N
Should | alter my archives when a person demands it? »
Can | report inaccurate testimony given in open court?
What are the laws about liquor advertising?

These are questions answered by the attorneys for the OPA Legal Services
Plan members in recent months. OPA members always need timely legal
advice on issues related to publishing.

You should join OPA’s LEGAL SERVICES PLAN!

See www.OkPress.com/LSP or contact Mark Thomas
at (405) 499-0033 or toll-free in Oklahoma at 1-888-815-2672 today!
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Two Oklahoma newspapers
win NNA contest awards

The National Newspaper
Association recently released
a list of winners in its 2024
Better Newspaper Editorial
Contest.

Two Oklahoma newspa-
pers — Marietta Monitor and
Southwest Ledger — received
honors in the contest.

The contest received 1,513
entries with 676 awards won
by 92 newspapers in 32 states.

The Marietta Monitor
received 11 awards including
two firsts for Best Non-Profit
Feature Story and Best Online
Album or Slide Show.

The Monitor placed second
in Best Breaking News Photo
and Best Sports Story; third in
Social Media Journalism and
Best Informational Graphic;
and Honorable Mention for
Best Non-Profile Feature
Story, Best Online Album or
Slide Show, Best Information-
al Graphic, Best Front Page

Design and Story Series —
Preserving Local History.
The Southwest Ledger won
10 awards. The Ledger placed
first for Best Profile Feature
Story; Best Business Story;
Best Reporting on Local
Government; and News and
Opinion on Public Corruption.
The Ledger placed sec-
ond for Best Feature Series
and Best Reporting on Local
Government; third for Best
Editorial and Best Reporting
on Local Government; and
Honorable Mention for Best
Serious Column and Best In-
vestigative or In-Depth Story.
Awards will be present-
ed September 26-27 at the
NNAF’s 138th Annual Con-
vention and Trade Show in
Omabha, Nebraska. For more
information or to register for
the convention, visit nnafoun-
dation.org/convention.

ORDER YOUR 2024
PHOTO ID PRESS CARD

OKLAHONA PRESS ASSOCIATION

YOUR NAME

555-555-5555

Make sure you add a photo ID press card to
your toolkit.

These press cards are perfect for reporters,
photographers and other staff members at
your newspaper.

Only $7 each!

ORDER ONLINE AT
okpress.com/press-cards

FOR SALE
OKEMAH NEWS LEADER

Serving @
(@kemah N eader

Okfuskee County
since 1921

Weekly

County seat paper and
only paper in the county

Online archives

‘Pﬂ.um 62024

Contact: Roger Thompson
Office: 918.623.0123
Cell: 918.623.7355

KIDS WILL TRY
ANYTHING... |
JUST ADD THE

RIGHT F_LAVOR

Big Tobacco will stop at nothing
to addict Oklahoma kids.

Disposable vapes come in flavors like Sour Apple,
Mango and Blue Razz — making it easier for kids to
start vaping and smoking. Once addicted, kids can
stay hooked for life.

4 out of 5 kids who use tobacco start
with a flavored product.

THAT’S NOT

Join the fight to protect our kids at

TOBACCO STOPS WITH ME.com

A Program of

Bl TSET




JUNE 2024
DAILY, SEMI- AND
TRI-WEEKLY WINNER:

KYLE
PHILLIPS

The Norman Transcript

JUNE 2024
WEEKLY WINNER:

BRIAN
BLANSETT

The Lincoln County News

The OGE Photo Contest
was judged by a member of the

Oklahoma Journalism
Hall of Fame.

OU players celebrate winning the WCWS after the Sooners’ game against . o

Texas at Devon Park in Oklahoma City. View all winning phOtOS
Photo by KYLE PHILLIPS, The Norman Transcript, June 9, 2024 an d C Ont e St ru I es at

OkPress.com/

OGE-Photo-Contest

Enter and Win
a $100 Check from
OGE ENERGY CORP.

For more information
about the photo contest,
visit okpress.com/
oge-photo-contest

Left: Joy Alsip is all focus on a pop fly during the annual Chandler
softball camp. She made the catch with ease.
Photo by BRIAN BLANSETT, The Lincoln County News, June 6, 2024

OG /L PHOTO CONTEST

‘ l At OG&E, we do more than — OG/E

4 ” B cnergize apower grid. We Energize Lo
‘ e We honor our commitment to strengthen our communities.

© 2021 OGE Energy Corp.
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OKLAHOMA NEWSPAPER FOUNDATION

2024 Summer Interns

Thanks to a grant from the Inasmuch Foundation, 18 college students received
paid internships at various newspapers and online news organizations across the

State.

The internship program, now in its 17th year, is facilitated by the Oklahoma

Newspaper Foundation.

This month, six interns share their experiences. More will be featured in the
September and October issues of The Oklahoma Publisher.

BY RAYNEE HOWELL, cushing Citizen — Oklahoma State University

When J.D. Meisner, the
publisher for Cimarron Valley
Communications, called me an
hour after my interview to ask
me to be their summer intern, |
responded with “Yay!”

Who responds to a job offer
with yay? Well, | guess | do. Now
in hindsight, | can say “Yay!” was
the most appropriate response.
Over the last couple of

Pitching my own ideas,
writing my own column...

taught me more about myself, my
abilities and how | can improve.

months, | have gained valuable
experience in arguably one of the
most important fields of journal-
ism, community journalism.

I've learned it's crucial for
small communities who never find
themselves in national or even
state-wide headlines, to have a
local newspaper. Our local papers
tell local stories.

For an entire summer, | was
a part of the team who got to tell
those stories.

From writing profiles on the lo-
cal election to covering a competi-
tive cheer team winning nationals,
I've had the opportunity to do it
all. Pitching my own ideas, writing

When my time at The Lawton
Constitution started, | was as
nervous as could be. | had written
for USAO’s student newspaper,
The Trend, but | was starting at
a newspaper in a city five times
the size of my hometown of
Chickasha without any real-world
experience. My goal going into
the internship was to become a
sports journalist, and even though
that is still in my career path, |

my own column and covering
whatever Allie Prater threw at me
taught me more about myself, my
abilities and how | can improve.

Thanks are in order to the
Oklahoma Press Association, the
Oklahoma Newspaper Founda-
tion, J.D. and Allie for giving me
this opportunity to learn and fur-
ther my career in journalism. As |
enter my last three semesters at
OSU, | am bringing my internship
experience with me — an experi-
ence | wouldn't have without their
generosity.

With the small, intimate staff
at CVC, | have gotten to know
each of my coworkers. DeAnna

quickly learned how valuable
community journalism is and the
impact it can have.

My first time walking into the
doors of the Constitution, | felt un-
prepared to handle the day-to-day
work of a newspaper, but thanks
to the help of Managing Editor
Dee Ann Patterson and the rest of
the reporting staff at the Constitu-
tion, | felt at home instantly.

In my first week, | was

INASMUCH

FOUNDATION

Maddox, Sapphire Smith, Allie,
J.D. and even Adobe and Typo,
the office cats, have helped me
put my best foot forward during
my limited time here. (I don’t know
how | would've gotten anything
done without Adobe scratching
my arm each time she wanted
attention.)

From work lunches at Papa
Chuy’s in Mannford to late night
Uno games at the OPA Conven-
tion, being a part of CVC makes
you feel a part of a community. A
community covering communities;
that's what it's like writing for the
Cushing Citizen, Yale News and
The Keystone Gusher.

As a girl from a small town in
Oklahoma, it has been a pleasure
to write for you, and | hope | did
your small towns justice.

Now, | am going to cry and
cuddle with the cats one last time.

BY MATTHEW YOKUM, The Lawton Constitution — University of Science and Arts of Oklahoma

shocked by how quickly they were
getting me involved. | was writing
stories my very first day and by
day two, | had already gone out to
do a story over Meers hamburg-
ers near the Wichita Mountains
Wildlife Refuge. This story is a
highlight of my summer, not only
because | ate a delicious ham-
burger, but because | learned that
amazing people could come from

Continued on Page 7



Continued from Page 6

anywhere, even an abandoned
mining town.

Coming into the internship,
I had hopes of writing sports
stories, but | knew they would
be few and far between during
the summer. | quickly learned to
appreciate the lack of sports, as
| got to learn about the Lawton
community more with each story
| was assigned. | have written
advances for community fund-
raisers, covered stories over the
military, sports features, all the
way to missing persons cases and
anything in between. From this, |

learned how diverse and active the
community you work in can be.

For eight weeks | inserted
myself in the Lawton community
and learned to appreciate every
interaction | had as a simple story
could turn into an interesting one
in a glance. While covering an an-
nual memorial service in remem-
brance of the Korean War, a man
called me over knowing | was with
the newspaper and introduced me
to a 94-year-old veteran of the Ko-
rean War. He had been stationed
in Korea with the last all-black regi-
ment in the United States Military,
the 24th Infantry Regiment, which
disbanded in 1951. Every year
the service honors the soldiers

2024 SUMMER INTERNS

In my first week, | was
shocked by how quickly

they were getting me involved.
I was writing stories my very

first day...

who made the ultimate sacrifice.
Meeting that man and hearing his
story was truly unique and shows
that everyone has a story to tell.
In my eight weeks at The Law-
ton Constitution, | learned how to
cover community journalism better
than | expected. Fellow reporters
Kim McConnell and Scott Rains
gave me a blueprint on what it
means to be a great community

journalist with their passion, work
ethic, and involvement in the
community. Patterson has given
me incredible guidance over the
summer, and | feel like | couldn’t
have found a better fit than the
Constitution. The experience and
lessons | learned during my time
at the Lawton Constitution are
priceless and | will remember my
time here for the rest of my life.

BY JENTEZEN SMITH, 7he Lincoin County News — Oklahoma Baptist University

Only 280 hours later, it’s hard
to believe it’'s already over. It feels
like last week when | walked into
The Lincoln County News and my
editor Brian Blansett welcomed
me with a soft tone saying, “Come
onin’

Baylee Blancarte and Emily Kalka
treated me with nothing but re-
spect and kindness, always being
a helping hand. They all made
it easy for me to be comfortable
in my role and | quickly came to
love LCN. | not only bonded with
my coworkers, but also our office
baby, Banks, Baylee’s son. Banks
was my buddy and a daily reason
to smile.

The main reason | smiled,
though, is because | loved my
job and being a journalist. Every
day was an opportunity, and as
they went by, my career path only
became further cemented.

| plan to be a sports journalist
and Brian helped me follow that
passion, covering pro boxers,

Every day was an
opportunity, and as they

went by, my career path only
became further cemented.

| ended up doing five in-
terviews in my first week and
learned photo techniques while
shadowing Brian. He refined my
work and gave me advice, but he
never talked down to me.

Along with that, my coworkers

rodeo, softball, football, racing,
baseball, track, cycling and sports
video games.

He also challenged me to
grow in generic journalism, where
| covered farmers, muralists, code
inspectors, highway and lawn

care workers, school employees
and events.

Amid covering everything,
Brian had me take pictures at
every interview | did and even
sent me on specific photo assign-
ments. | can gladly say I've grown
substantially as an all-around
journalist and a photographer and
formed a passion for both.

In all my work, what stuck out
to me the most was an interview
with Wirt Trawick, a 94-year-
old veteran and 1948 Stroud
graduate. In both of his healthy
marriages, Wirt’s wives passed
away. Though he was all alone in
assisted living, Wirt was noth-
ing but joyous and kind. In our
interview he talked about his life
stories in happy remembrance,
and specifically his Stroud football
days. Smiling, he told me about
planning his own funeral and writ-
ing his obituary, just joyful to be
able to go out on his own terms.

Getting to interact with Wirt
struck me deep down about the
importance of journalism.

Interviewing him, hearing
about his amazing journey and
seeing how much joy he had
because of my story about him,
made me realize something. That,
just like him, all people deserve

to have their story told. Everyone
has a story deserving recognition
and | want to help tell it. | wouldn't
have realized that without this in-
ternship and for that I'm eternally
in debt to the Oklahoma Newspa-
per Foundation and LCN.

Thank you to both for this
amazing opportunity and growing
me as a journalist. Thank you to
Emily and Baylee for not treating
me like an intern but respecting
and helping me as a coworker.
Thank you, Banks, for being a
buddy.

And for my last thank you,
here’s some context. While at
an OPA convention, everyone
talked about Brian in the highest
regard, telling me “There’s no one
better to learn from” and “l was in
good hands”” I'm not sure if I've
heard anything more true. Brian’s
invested so much time and energy
into me, taking me under his wing
and showing me what being a
professional journalist is. One
day, | hope to hold even half the
credibility and respect that people
have for Brian.

It was an absolute pleasure
being The Lincoln County News
summer intern and | can’t wait to
see where my experience takes
me next.

=l Jaysiiand ewouyepo 8y | #20z snbny
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2024 SUMMER INTERNS

Two years ago, | wrote in my
Oklahoma Newspaper Founda-
tion internship farewell column
that “a newsroom internship is
an experience unlike any other”
That still rings true for me today
as | conclude my third newsroom
internship to date.

When The Purcell Register's
John Denny Montgomery emailed
me seemingly out of the blue in
mid-May asking if | was interested
in joining his staff for a summer
internship, it was an incredible

surprise and unexpected blessing
as an internship opportunity | had
previously been offered had fallen
through with little notice.

With each newsroom intern-
ship, | have learned more and
more about the world in which
we live. Upon being handed the
responsibility of covering the city
council and the local school board
over the summer, | jumped at the
opportunity to learn more about
how a city government functions
and all the different kinds of
decisions they must make.

That first Purcell City Council
meeting | attended in June lasted
about five hours. In that meeting,
| heard agenda item after agenda
item, but only two really caught
my attention — a discussion
regarding the potential de-annex-
ation of hundreds of acres of land
and consideration of a master
development plan rezoning more
than half of the same land.

| knew then and there that

b \

L t/ . ‘

When | agreed to take the in-
ternship position with the Guthrie
News Leader, | really didn’t know
what to expect since | had no
prior experience working with a
small-town newspaper.

As the internship draws to a
close, | can look back and say
that | am happy that | did. The
experience | gathered has grown

my journalism skills in ways that
sitting in a classroom can not.

While at OU, my writing
primarily focuses on athletics with
my work at the OU Daily. Howev-
er, sports reporting and small-
town newspaper reporting are
two completely different worlds.
Working with the News Leader
opened my eyes to a different
type of journalism that will benefit
me when it comes time to find a
job once my senior year at OU is
complete.

| also had the chance to work
with the News-Leader’s sister
paper, The Edmond Way, as part
of my internship. With Edmond
being my hometown, it was fun
to report on what was going on
in the town that | grew up in,

this was the story that would
envelop my summer. | poured
over hundreds of pages of open
records, whether they be budgets,
development plans or articles
from decades past. Council meet-
ing summaries notwithstanding, |
wrote two stories about the issue,
which goes at least as far back
as 1997.

BY KATRINA CRUMBACHER, 7he Purcell Register— University of Oklahoma

Schools, which would be inundat-
ed with any school-age children
of families who might move to the
new development should it be
built out as planned.

It just goes to show how local
news is vital to a community.

Ready as | am to return to the
University of Oklahoma for my
final year of college, | cannot help

With each newsroom
internship, | have learned

more and more about the world in

which we live.

| spoke with a rural home-
owner whose property overlaps
with the land potentially to be
de-annexed. | spoke with one of
the McClain County commission-
ers who has been pushing for
this land to be developed since
at least 2009. | spoke with the
superintendent of Wayne Public

BY TREY DALLAS, Guthrie News Leader — University of Oklahoma

but be thankful for the wonderful
experience I've had working with
The Purcell Register staff this
past summer. | also want to ex-
tend my gratitude to the Oklaho-
ma Newspaper Foundation Board
of Trustees and the Inasmuch
Foundation for this incredible
opportunity.

The experience | gathered
has grown my journalism

skills in ways that sitting in a
classroom can not.

something that I had not previous-
ly done.

[ loved reporting on stories
and events in both Edmond and
Guthrie. In Edmond, my work
at the beginning of the intern-
ship was primarily devoted to a
sculpture park saga, which had
roots dating back to 2021. | also
covered Edmond’s LibertyFest
and other stories around town.
Assignments in Guthrie allowed
me the opportunity to cover
graduations, crime and other local

community news that the town
needed.

| would be missing an oppor-
tunity if | didn’t offer my gratitude
and appreciation to those that |
worked with this summer: Ro-
chelle Stidham, Jennifer Tennyson
and Erin Stevens. | sincerely
appreciate their guidance and
assistance to me throughout the
entire summer. It was a wonder-
ful experience for me to work in
Guthrie and Edmond.



2024 SUMMER INTERNS

BY KYRA HUCKABAY, Weatherford Daily News — Southwestern Oklahoma State University

“No two days are alike”

This phrase comes to mind
when | think of my internship at
the Weatherford Daily News.

Some days, | took pictures
during story time at the Weath-
erford Public Library. Other days,
| attended a city commissioner

meeting to relay information about
agenda items being discussed.
More recently, | wrote an article
about a top-secret F-117A “Night-
hawk” Stealth Fighter aircraft,
which arrived at the Stafford Air
and Space Museum.

Every task | was assigned this
summer provided an opportunity
for me to learn. | have made
numerous connections throughout
my internship and | continue to be
inspired by each person | meet.

| remember the first article |
wrote for the Weatherford Daily
News was in the memorial edition
in honor of Lt. Gen. Thomas P
Stafford, who passed away two
weeks before | began my intern-
ship. Lt. Gen. Stafford is a local
hero in Weatherford who was a

This experience has allowed
me to grow, both as a writer
and as a person.

U.S. Air Force officer and NASA
astronaut. The memorial edition
newspaper was special to me be-
cause it contained my first article,
but also because it honored Lt.
Gen. Stafford.

| grew up in Mangum and my
elementary school class took a
field trip to the Stafford Air and
Space Museum here in Weath-
erford and | thought it was the
coolest experience. Having my
first article be included with the
hero | learned about in elementa-
ry school was a full-circle moment
for me and is one of my favorite
memories looking back.

This experience has allowed
me to grow, both as a writer
and as a person. In the last few
months, | have gotten involved
in the community, learned who
each local government official is
and continue to be knowledge-
able about events and projects
happening in Weatherford.

The most rewarding part of my
job is going in public and seeing
people read newspaper articles
with my name attached to the
byline or hearing people say “I
read in the newspaper the other
day..” and they explain a story
written by me. It assures me how
crucial local journalism is and why
| continue to do what | do.

| am grateful for this expe-
rience and each individual at
the Weatherford Daily News for
teaching me something new
every day. | would like to extend
a special “thank you” to Publisher
Phillip Reid and Managing Editor
Josh Burton. These two have
not only taken a chance on me,
but allowed me to have creative
freedom while still helping me
along the way.

Lawton Constitution Publisher David Stringer presents Lisa Carson, executive
director of the Lawton Public School Foundation, with a check from the Car-
mage and Martha Ann Walls Foundation. United Way of Southwest Oklahoma
and The Salvation Army also received gifts from The Constitution this year.
(Photo by DEE ANN PATTERSON, The Lawton Constitution,)

Thanks to a gift from the
Carmage and Martha Ann
Walls Foundation, The Lawton
Constitution directed $7,500
to be split among the Salvation
Army, United Way and Lawton
Public School Foundation.

The gift allows publishers
at all Southern Newspapers
Inc.-owned newspapers to
choose local profit or non-prof-
its to receive funds each year.

“Walls Foundation gifts
allow our paper to make a sig-
nificant impact on nonprofits
that make our area better and
help local volunteers to carry
out their mission,” said David
Stringer, publisher of The
Lawton Constitution.

Organizations that received
Walls Foundation grants for
2024 provide services for
people with dementia and
their caregivers, meals, crisis

funding, housing assistance,
literacy services, job training,
counseling, animal rescue and
adoption, healthcare to the
underinsured and drug rehabil-
itation support, among other
critical services.

In the past 14 years, the
foundation has given more
than $3.5 million to the 11
community newspapers owned
by Walls in Texas and Okla-
homa.

“I’'m proud to be part of
a company that places pri-
ority on giving back to its
communities,” Stringer said.
“We literally are invested in
our towns in so many ways,
including employing local
people, practicing accountabil-
ity and community building
journalism, helping our local
businesses reach customers
and so much more.”

A gift allows Lawton Constitution to donate $7,500
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New editor joins The Norman Transcript

The Norman Transcript has
named Ben Fenwick as its new
editor.

Fenwick has written for

Reuters and the New York
Times, as well as The Daily
Oklahoman, Tulsa World, the
Oklahoma Gazette, Oklahoma
Watch and The Frontier, and
provided coverage from Bos-
nia, Afghanistan and Iraq as a
war correspondent.

“I’m excited and grateful
for the opportunity to join
the team at The Transcript.
Norman is a wonderful place
to live and a great news town.
This is also an amazing time to
be a journalist,” said Fenwick.

After graduating from the
University of Oklahoma with
a bachelor’s degree in journal-
ism, Fenwick started his career
covering Norman before

moving on to cover general
assignment reporting in down-
town Oklahoma City.

While working for KGOU
as a news announcer, Fenwick
returned to Norman to pursue
a master’s degree in journal-
ism.

“We are thrilled to have the
opportunity to add someone
of Ben’s talent, experience
and caliber to The Transcript
team,” said Katherine Miller,
publisher of The Transcript.
“We have worked diligently
to add some new talent to our
newsroom, and I know Ben
will do amazing things leading
this team.”

Smith returns to Trail Miller Inc.

Austin Smith is return-
ing to Trail Miller Inc. to
become managing editor of
The Okeene Record and The
Dewey County Record.

Smith was first hired by
Trail Miller Inc. in 2018 as a
sportswriter/editor. After near-
ly six years with the company,
he returned to Texas to take
the position of sports editor
for a handful of newspapers
north of Dallas.

During his nine-month stint
in Texas, Smith continued
covering sports for Okeene
and Seiling.

“I knew I didn’t want to
stop covering these pro-
grams,” said Smith. “These
are special communities with
incredible people from top to
bottom. I grew so much as a
person and professional during
my time here and wasn’t ready
to turn loose of that complete-
ly.”

Paul Laubach, publisher/
manager of Trail Miller Inc.,
said, “Austin’s return is a
tremendous blessing for our
local newspapers and our
communities.

“I sincerely look forward

to him taking a larger role
with the papers.”
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Tulsa World
continues NFS

news for students

The Tulsa World’s News
for Students program is
again offering compli-
mentary digital subscrip-
tions for Tulsa-area teachers
and their students this
school year.

Educators and students at
any school in the Tulsa area
are eligible.

Just like last year, the of-
fer provides complimentary
unlimited digital access to
tulsaworld.com, the daily
Tulsa World e-edition show-
ing all pages of that day’s
print edition. It also includes
the Tulsa World app and the
Tulsa World Archive online
of more than 2.3 million
photos, and 58,000 videos.
E-editions of the Sand
Springs Leader, Owasso
Reporter, Skiatook Jour-
nal and Wagoner County
American-Tribune are also
included.

The News for Students
subscription allows teachers
and students to stay current
on relevant issues includ-
ing the latest coverage of
breaking news, local news,
sports, arts, entertainment,
and perspectives in editori-
als, letters to the editor and
opinion columns written by
Oklahomans.

“Our goal is to give
readers access and insight
into the community around
them,” said Jason Colling-
ton, editor of the Tulsa
World.

“In this second year the
program, we really want to
be a part of the classroom
and show students the
important role journalism
plays in society.”.




Beau Simmons named editor of News & Eagle

The Enid News & Eagle re-
cently named veteran Oklaho-
ma journalist Beau Simmons
as editor.

The announcement was

made by Jeff Funk, publisher
of the News & Eagle.

Simmons will lead the
experienced Enid newsroom
team, including Associate
Editor Kevin Hassler, who has
worked at the News & Eagle
for nearly 40 years.

Simmons is a graduate of
Northeastern State Universi-
ty. He has served as reporter
or editor for four Oklahoma
newspapers over the last two
decades, most recently as edi-
tor of The Norman Transcript
and Stillwater News Press.

Simmons will continue to
serve as editor of the Stillwa-
ter News Press and has also

Wright joins The Transcript

Lucas Wright recent-
ly joined the staff of The
Norman Transcript as a sales
representative.

Wright, who grew up in
New Mexico, moved to Nor-
man in March and started his
own business, Tiger Melon
Photography.

Wright said he hopes to
continue to grow his pho-
tography business while
establishing a place in the
community.

“I think they’1l work
together so that we can be
successful here and there,”
said Wright.

He hopes to bring good
customer service and creativ-
ity to The Transcript.

“It’s a creative industry
in general,” Wright said. “So
even from the sales perspec-
tive of things, you can bring a
lot of creativity as well.”

taken on editor duties at the
Woodward News.

“Beau has been successful
at leading print and digital
news teams in finding cre-
ative ways to report and share
news,” Funk said. “He is well
qualified to help the News
& Eagle communicate with
readers throughout Northwest
Oklahoma.”

Simmons began his jour-
nalism career in 2002 as a
general assignment reporter in
Pryor. From there, he worked
for the Durant Democrat as a
sports editor, joined The Tran-
script in 2009 as news editor

and became editor of the News
Press in 2015.

Simmons also serves as
deputy regional editor for the
13 Oklahoma newspapers
owned by CNHI, LLC.

“We have a lot of collab-
oration within Oklahoma’s
CNHI newspapers, so I've
become very familiar with
the News & Eagle’s excellent
journalism, and I’m excited
to lend what I can to the Enid
newsroom,” Simmons said. “It
is among the most experienced
newsrooms in the state of
Oklahoma and has a great feel
for community-driven news.”

Open Records dispute settled

An open records dispute
between Stephens County Dis-
trict Attorney Jason Hicks and
two Oklahoma lawmakers has
been settled, Oklahoma Watch
recently reported.

Stephens County Judge
Brent Russell granted the
defendant’s motion for sum-
mary judgment, ruling that
Hicks has produced all records
requested by the plaintiffs and
that there is insufficient evi-
dence to prove otherwise.

Oklahoma Watch reporter

Keaton Ross said Reps. Justin
Humphrey, R-Lane, and Kevin
McDugle, R-Broken Arrow,
filed the lawsuit last Decem-
ber. The lawsuit claimed that
Hicks withheld communica-
tion records relating to death
row inmate Richard Glossip’s
April 2023 clemency hearing.

Glossip’s execution re-
mains on hold while the U.S.
Supreme Court considers his
writ of certiorari.

(See CV-2023-00204R on
OSCN.net)

CHICKASAW NATION

MEDIA RELATIONS
Loné Beasley
580-559-0921
lone.beasley @ chickasaw.net
chickasaw.net

ETYPE SERVICES
Thad Swiderski
512-687-9055
thad @etypeservices.com
etypeservices.com

FEED THE CHILDREN
Carrie Snodgrass
(405) 213-9757
carrie.snodgrass @

feedthechildren.org
feedthechildren.org

STRATEGIC PARTNERS

GRAND RIVER DAM AUTHORITY
Justin Alberty
918-256-5545
justin.alberty @grda.com
grda.com

MENTAL HEALTH ASSOCIATION
OKLAHOMA
Adi McCasland
405-250-6331
amccasland @mhaok.org
mhaok.org

METRO CREATIVE GRAPHICS
Jennifer Steiner
800-223-1600
jsteiner@metro-email.com
metrocreativeconnection.com

OGE ENERGY CORP.
Christi Woodworth
405-553-3698
woodwoco @oge.com
oge.com

OKLAHOMA ASSOCIATION OF
ELECTRIC COOPERATIVES, INC.
Chris Meyers
405-478-1455
cmeyers @oaec.coop
0aec.coop

OKLAHOMA BAR ASSOCIATION
Janet Johnson
405-416-7000
janetj@okbar.org
okbar.org

OKLAHOMA DEPARTMENT OF

REHABILITATION SERVICES
Jody Harlan, Comm. Director
405-203-1318
jharlan@okdrs.gov
oklahoma.gov/okdrs.html

OKLAHOMA MEDIA CENTER
Rob Collins, Executive Director
405-205-9421
rob @ oklahomamediacenter.com
oklahomamediacenter.com

OKLAHOMA NATURAL GAS
Chad Previch
405-501-9509
Chad.Previch@onegas.com
oklahomanaturalgas.com

OKLAHOMA STATE SCHOOL
BOARDS ASSOCIATION
Christy Watson, Comm. Director
405-528-3571
christyw @ ossba.org
ossba.org

PHILLIPS THEOLOGICAL
SEMINARY
Kurt Gwartney
918-270-6470
kurt.gwartney @ptstulsa.edu
ptstulsa.edu
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OPA hosts NAM meeting in Oklahoma City

Snapshots from the Newspaper Association Managers meeting.

S
Lisa Hills of Minnesota Newspaper Association and Laurie Hieb

of Oregon Newspaper Publishers Association enjoy a stage-
coach experience at the National Western Heritage Museum.

North Carolina Press Association Executive Director Phil Lucey records his visit to the Oklahoma City
National Memorial.

v

- ,
NAM Clerk Layne Bruce of Mississippi, Vice-President Brian
Allfrey of Utah, and President Mark Maassen of Missouri display
NAM members reflect on the tragedy of the Oklahoma City bombing as they tour the memorial grounds  branding iron gifts given by OPA for their service to NAM. Mark
at dusk. Thomas, Oklahoma Press, at right.

Closeup of head of show iron given to NAM President Mark

— Maassen. The head of a show branding iron is reversed to read

Mark and Debbie Thomas of Oklahoma express sentiments about Texas, pictured alongside Texas Press  properly when shown to guests and friends. Irons were pur-
Association Executive Director Mike Hodges and wife llene, a graduate of Oklahoma State University. chased from Ihbrandingirons.com in Mandan, ND.
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Sequoyah County Times high

Looking

Them Over
by Rod Serfoss
rserfoss @ okpress.com

Well written stories,
outstanding photographs and
graphics, exceptional compo-
sition and quality press work
make the Sequoyah County
Times one of the premier
newspapers in Oklahoma.

A recent series of stories
by Lynn Adams titled “On
the streets where you live”
addressed the homeless
population in Sallisaw, a town
of 8,500 people in far eastern
Oklahoma.

Bolin resigns as

Sallisaw softhall coach '

trend is a problem
that can’t be ignored

Search begins for
new city manager

Criminalizing homelessness
isn’t answer to the problem

The series began in July
containing stories including:

“Growing homelessness
trend is a problem that can’t
be ignored”;

“Criminalizing home-
lessness isn’t answer to the
problem”;

“Are love and compassion
answer to homelessness?”;

“Homeless encampments
outlawed”;

“Soup N Soulz ministry at
The Shed seeks to help Sal-
lisaw’s homeless”;

“Homelessness, mental
health can intersect for those
on the streets”;

“‘Everyone is doing the

best they can to remedy city’s
homeless problem”;

“Homeless sacrifice health-
care to survive each day on
the streets” .

Two more articles in the
series are scheduled in August.
One is an interview with a
small downtown business
owner affected by the home-
less issue and the other a
column by Adams about his
wife’s life being saved by a
homeless person.

Each of the well written
stories demonstrates the Times
commitment to community
leadership and in-depth report-
ing in order to make its town
better.

It would have been much
easier to write one story, cover
a meeting and call it good, but
that is not the Sequoyah Coun-
ty Times’ way of doing things.

Each year OKC Friday
polls its readers to find who
they think are the most pow-
erful Oklahomans. This year
Friday readers put Chickasaw
Nation Governor Bill Anoa-
tubby at the top of the list.

Rounding out the top five
were Oklahoma City Mayor
David Holt, OKC Thunder
Chairman Clay Bennett,
Attorney Tricia Everest and
Attorney General Gentner
Drummond. Oklahoma Gover-
nor Kevin Stitt came in at 13.

I also enjoy reading the
quotes that regularly appear
on the top of Friday’s opinion
page.

. “And you shall know the
truth and the truth shall
set you free.” — John
8:32, quoting Jesus

e “The only thing neces-
sary for the triumph of
evil is that good men do
nothing.” — Edmund
Burke paraphrase, 1767

e “If you want it in the
paper, it’s advertising.

If you don’t want it in
the paper, it’s news.” —

Ancient Chinese Proverb.
(My favorite.)

. “Without, or with, of-
fense to friends or foes,
we sketch your world ex-

actly as it goes.” — Lord
Byron, 1818
e “Every violation of truth

is a stab at the health of
human society.” — Ralph
Waldo Emerson, 1878

*  “We must always stand
— alone if necessary — as
the conscience of the
community.” — J. Leland
Gourley, 1959

-
\NbODWARD NEWS

Woodward school leader waits for more
gmdance on Blbles inlocal classrooms

Woodward News Assistant
Editor Rachael Van Horn did
a good job combining with
CNHI News Oklahoma’s
Jessica Marshall to localize
a story about the Oklahoma
State Department of Education
mandating all schools must
teach the Bible.

Van Horn’s story didn’t end
when the local superintendent
said, “It’s too soon to tell how
the mandate will be imple-
mented here.”

She went on to tell the
superintendent has no problem
with the Bible and displaying
the U.S. Constitution and
10 Commandments, but he
believes how to properly apply
the new mandate to students
in every classroom has been
under-researched. The story
also said he is not instructing
anyone on his staff to rush out
to spend around $4,500 to put
Bibles and the two other docu-
ments in the 213 classrooms in
Woodward.

ights homelessness

The Ponca City News
recently produced a special
section titled “Welcome,
neighbor” that showcased
the northern Oklahoma town
of 24,000 to newcomers and
those considering making it
their home.

The section included 20
pages of informative stories
and pictures about the must-
see attractions and history
of the city. It also had lots of
advertising to make sure both
new and current residents
know where to do business.

From its office in Hinton,
The Country Connection has
taken on a new look and is
expanding how it connects
with readers.

Last month, CC Publish-
er Cory Cart launched the
Country Connection Book
Club “to foster the love for
reading while celebrating the
rich history of Caddo County
and the state of Oklahoma.”
The club will focus on books
by local authors, Oklahoma
writers and topics of interest to
the community.

TOP FIVE HEADLINES:

5. From fun to tragedy in a
heartbeat
— Kingfisher Times
& Free Press

4. Whiskey still shut down,
Roland man charged
— Eastern Time Register

3. Alittle Tequila, Meth,
and No Insurance
— Atoka County Times

2. Canine Flatulence
— Frederick Press-Leader

1. Accused claims he was
auditioning for porn job
— McCurtain Gazette

OPA Business Consultant Rod
Serfoss looks over OPA member
publications for “Looking Them Over,’
a monthly column. To contact

Serfoss, email rserfoss @ okpress.com.
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Get ready for the new school year by creating forms

h Computer Notes
=S from the road
VoA

|5 A

by Wilma Newby
wnewby @okpress.com

Most newspapers are busy
getting ready for the upcoming
school season.

It’s a busy time spent
gathering names and mug-
shots of student players that
will be used over the next few
months.

To make it easier, try set-
ting up some forms ahead of
time with tabs and tables for
stats. This idea could even be
used for election results.

If you’re using InDesign,
the first step is to set up a type
block with the text tool.

Decide how many tabs will
be used per line by typing a
dummy line of text with tabs
in it. Don’t worry about the
order of the tabs yet.

While you’re still in the
type block with the flashing
“I” beam, do a Select All
(under Edit > Select All or use
the Command/Control + A
keyboard shortcut).

In InDesign (ID), go to the
Type menu and slide down to
Tabs to bring up the controls
for tabs. For QuarkXPress
(QX) users, hit the tabs button
in the measurements palette at
the bottom of the screen.

Players Name Jersey # Position Blocks Made Receptions Made
Joe 45 Defensive End 36 0
Chris 27 Middle Linebacker 45 0
Tim 30 Strong Safety 38 1

Set the tabs to decimal, left
or right, by choosing the tab
placed on the clear bar so it is
highlighted blue/black; now
click the icon symbol for that
command that says flush right.
Drag to the desired location or
type in values.

It can be tricky at first to
get thing right — that’s why
we’re doing it ahead of time.

After the tabs are set delete
the text that was used to set up
the tabs leaving one line and
add to a library for further use.

If you do not have a library
create one under File > New >
Library... Name it something
like football setups and then
select your desktop and hit
Save(ID)/Create(QX). Items
dragged into the Library will
be available to new documents
created throughout the season.

Drag your text block with
the setup tabs into the library
and give it a name.

Now let’s make that text
block into a table that will be
attractive to readers.

First, select all within the
type block. Now in ID or
QX go to the Table menu and
down to Convert Text into

Tabs

$od v b x| Leader:‘

Align On:

13 < L

=
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#  Position
Defensive End

[Players Name ~ Jersey #

Joe 45

" Blocks Made

36

Chris 27

Middle Linebacker

45

Table. Leave the next box as is
and click OK.

In ID you can center all the
text while it’s selected with the
keyboard shortcut Command/
Control + Shift + C.

QX creates a new table
object so each block must be
adjusted separately. It might
be best to create centered tabs
in the first table before con-
verting it to a table.

After the table is made,
use the Table menu to create
effects such as shading every
other row. You’ll find this op-
tion in ID under Table > Table
Options > Table Setup.

Now that the table is setup
for the new school year, drag it
into the newly created Library.

EXTERNAL DRIVES

Let’s take a look at how
to format external drives the
right way on a Mac for use
with Time Machine.

Apple has several file
formats for Macs ranging
from APFS for newer Macs to
HFS+ (also known as Mac OS
Extended Journaled) for Macs
born before MacOS 10.13
High Sierra.

Most external hard drives
come formatted as DOS for
Windows making it confusing
to set up a recoverable Time
Machine backup drive.

To completely recover your
Mac with Time Machine, the

) LEGAL ADVICE

is just one of the benefits of being a member of the Oklahoma Press
Association’s Legal Services Plan. Remove the worry of needing
professional advice by enrolling today. For more information contact:

OKLAHOMA PRESS ASSOCIATION’S
LEGAL SERVICES PLAN

1-888-815-2672 or 405-499-0020

system and all the files on the
external drive must be format-
ted to the same format as the
internal drive on the computer.
When adding a new drive
first click on the internal drive
of the computer and go to File

General:

Kind:
Created:
Modified:
Version:

Volume
Septen
Septen|
14.0

> Get Info. On
the example at
left, the format
is APFS.

We need the

Format: APFS

external drive
to have the same format as the
internal drive on the computer.

To get the External Drive off
a Windows format and change
it to APFS or Mac Journaled
depends on the age of your
computer.

To format the new drive
with Disk Utility, look under
the Go menu while on Desktop
> Utilities. In that folder you
will find Disk Utilities.

Choose the External Drive
and Erase. (Make sure it says
External before erasing.)

Erase “Crucial X6"?

@ Erasing “Ci
£\ can'tundo

ial X6” will permanently erase all data stored on it. You
ction.

Format: ~ APFS

Security Options... Cancel Erase

After “Format:” choose
either APFS or Mac Journaled
Extended matching the Get
Info dialogue box.

Now set up the Time Ma-
chine. Go to System Settings
> general > Time Machine. Use
the “+” sign to add the newly
formatted drive so it will back
up the computer. This backup
will be able to fully recover
your computer.

To help the external drive
list, just plug in the backup
once a week.

< Time Machine

@
s

OPA Computer Consultant Wilma
Newby’s column is brought to you by
the Oklahoma Advertising Network
(OAN). For more information on the
OAN program, contact Oklahoma
Press Service at (405) 499-0020.



Reid Newspapers subscription special

. Fhat) Phiee )

Print AND Online
itat for ONE low price!

IE YEAR SUBSCRIP!

In a circulation promotion, Reid
Newspapers used a full page of the
newspaper to promote a half-price sub-
scription special.

For each one-year subscription, the
newspapers donated $5 of the purchase
to a nonprofit organization in the com-
munity.

Reid Newspapers, operated by Phillip
Reid, includes The Afton American,
Oologah Lake Leader, Weatherford
Daily News, The Grove Sun, Miami
News-Record, Delaware County Journal,
The Tribune in Bethany, Vinita Daily
Journal and the Grand Laker.

Enid News & Eagle provides Total Access

The Enid News & Eagle uses a house ad to remind readers

that they can access the newspaper with
a subscription “whenever, wherever,
however they want it”. The ad gets the
message out that a Total Access sub-

scription includes all platforms — print,

smartphone, desktop computer and tablet.
The subscription provides breaking news,
real-time weather, expanded photo galler-

Worth Mentioning =—————

Third annual School Supply Drive in Snyder

The Kiowa County Democrat in

Snyder is holding its third annual

School Supply Drive to help provide

extra supplies to Snyder Public

Schools. Supplies collected will be
delivered to the school offices tobe ~ —
used by students and staff as needed.

The Democrat referred readers to '

\L“‘/",
al=
g i 4

TN

the school supply lists printed in the
newspaper. An Amazon link for supplies that could be shipped
directly to the newspaper office was also provided.

Supplies as well as monetary donations could also be dropped

off at the newspaper office.

Coolest Canine photo contest in Watonga

The Watonga Republican is
asking readers how they keep
their furry friends cool during
the dog days of summer with a
“Coolest Canine” photo contest.

Readers are asked to upload
photos for a chance to win prizes
and bragging rights.

First place is a one-night stay
at a spa retreat for pets; second
place $50; and third place a one-

DOG DAYS
-, SUMMER

CaeltrSsCavtnd
Photo Contest,

The Dog Days of Summer are here, and
we want to see how your furry friends keep
their cool! Enter your favorite summer-
themed photo of your pup for a chance to

win.
Upload & Enter at: Winning Photos Will Receive
i com or Cash Prizes and Bragging
on our facebook page via Rights.
Facebook Messenger First Place: Twinkle Toes Pet
July 10 through July 23 fora  Spa Retreat or one night stay in
nce to their NEW overnight boarding
Second Place: $50
24 Third . ‘Place: One year

ies and social media commenting. year subscription to the newspaper.

Please donate to the

OKLAHOMA NEWSPAPER FOUNDATION

Donations to the Oklahoma Newspaper Foundation will support its efforts to

Remembering our friends
& colleagues who died the previous year.

Darlene Howard Karen Annette Miller

July 19, 2023 Radford Holt
improve the state’s newspaper industry and quality of journalism. Haskell Lee Gaither August 15, 2023
Checks may be sent to July 30, 2023 James ‘Jim’ Franklin Ellis
OKLAHOMA NEWSPAPER FOUNDATION Charles Joseph ‘Chuck August 22, 2023
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o OKLAHOMA NATURAL GAS CONTEST WINNERS

CONGRATULATIONS TO THE JUNE WINNERS
Column; GONNIE BURCHAM, Watonga Republican
Editorial: JEFF FUNK, Enid News & Eagle

JUNE EDITORIAL WINNER (Read editorial at okpress.com/ong-contest)

JEFF FUNK, Enid News & Eagle

Fight the Blight: City must force cleanup of
dilapidated pot farm at east Enid gateway

The city of Enid made a significant step this month in
addressing a frustrating ongoing problem at the eastern
entrance to the city along U.S. 412.

For more than four years, a now defunct marijuana grow
operation on the north side of the four-lane highway has
been allowed to deteriorate, with a large expanse of former
greenhouses now tattered, torn and falling apart.

I's an eyesore. It's ugly and unsafe. It's also located in a
highly traveled area with welcome-to-Enid signs. Not good.
City government has been patiently working with the
property owner, Amenda Ploeger, to clean up the high
visibility mess. Finally, the city’s patience ran out, and the
city issued a formal “abatement notice” or nuisance notice
giving Ploeger until the end of this week to clean up the
dilapidated property. If the landowner doesn’t act, the city
can move in and clean up the private property.

It's time.

To keep local taxpayers from paying the cost, the city likely
will place a claim or lien against the property. Because

the land at 3223 E. Randolph is very marketable property,
it's likely the city will recover any cleanup costs when the
property sells.

The old, planned cannabis grow operation, formerly the
home of Lucky Flower Farms, has been a terrible eyesore
and nuisance for years. Cleaning up the property is critical
to Enid’s image because the property at the city’s gateway
is so visible and prominent for visitors coming into the Enid
from the east.

Community cleanup has properly been a concern of city
government for some time. Last year, Enid city government
allocated $100,000 and substantial city staff time to clean-
ing up high-traffic corridors around the city. The city’s focus
of mowing and removing debris often provided incentive to
private property owners to step up their efforts and keep
property tidy and presentable.

That beautification effort along the city corridors was
positive and making progress, but its impact was modest
compared with potential of cleaning up the large and highly
visible blight along the east Enid gateway.

City government cannot police every piece of property —
far from it — but it's certainly time to move forward prompt-
ly on the defunct marijuana grow mess, with or without the
property owner’s cooperation.

JUNE COLUMN WINNER (Excerpts from column. Read entire column at okpress.com/ong-contest)

CONNIE BURCHAM, WWatonga Republican

A Bubble Off Plumb

| spent three weeks in Hell once. You might wonder how
one gets to Hell. I rode in atop an 18-hand red mule named
Moe.

Let me elaborate. You see, | had been hired as camp cook
for an outfitter in Hell's Canyon, Idaho. There is also an
Oregon side, but | wasn’t up for that much Hell.

Hell's Canyon is what the Frank Church River of No Return
Wilderness wants to be when it grows up. A rougher,
steeper or more rugged place God never put on a map. Or
if He did, | never heard about it.

The only ways in are on foot or by hooved animal. No
motorized vehicles, no roads only trails, no chain saws or
electric lights or indoor toilets. Remote doesn’t begin to
describe this place.

We packed in on my birthday in early October, cool, crisp
sunshine everywhere. After a 10-mile jaunt, we arrived at
the Log Creek Camp.

My only stipulation when | hired on was no bears. | don’t
like bears. | have a pathological fear of bears. No reason
why, but that's the thing about irrational fears—they are
irrational.

We dismounted to find a bear had ransacked the camp,
especially the cook tent, where | was to reside for the next
little while.

What a mess! It seems the bear had a particular fondness
for Tang and ate a whole flat of powder. The guide | was
with explained this was just a black bear, they didn’t have
grizzlies in this part of Idaho. On the other hand, he had
never seen a bear with a map. | was skeptical at best.

But life settled into its routine of starting fires and cooking
on the wood stove and packing huge lunches for the hunt-
ers. Until a day or so later. About 2 a.m. | was snuggled

in my down sleeping bag — it was about 20 degrees that
high in the mountains — when | heard the zipper on the
tent creep open. | sat bolt upright in my cot, a light in one
hand and a pistol in the other. | wanted to make sure it
wasn't a dentist from Michigan or the camp dog looking for
a midnight snack.

It was neither. It was the bear. Did | scream or shout? No.
| told the bear in a normal voice he couldn’t be there, and
he had to go.

Oklahoma
Natural Gas.

A Division of ONE Gas

G

Enter and Win a
$100 Check
from Oklahoma
Natural Gas!

The June Oklahoma Natural Gas
Column and Editorial Contest
was judged by a member of the
Oklahoma Journalism
Hall of Fame.

1. Each month, submit your entry
online at okpress.com/ong-
contest. Attachments should
be in PDF format.

2. Entries may also be emailed
(full-page tearsheet) to
amartin @okpress.com. Include
the author's name, name of
publication, date of publication
and category entered (column
or editorial).

3. All entries for the previous
month must be at the OPA
office by the 15th of the
current month.

4. Only ONE editorial and/or
ONE column per writer per
month will be accepted.

5. Winners will receive a
Certificate of Achievement, a
$100 check and the column
or editorial may be published
in The Oklahoma Publisher.
Annual Sweepstakes winners
will receive a plaque, a $200
check and may have the
column or editorial published
in The Publisher.

Contest open to staff at OPA
Legal Newspaper and General
News Media members, as well as
OPA Individual members.

Although Oklahoma Natural Gas
Company selects representative
contest winners’ work for use
in this monthly ad, the views
expressed in winning columns and
editorials are those of the writers
and don’t necessarily reflect the
Company’s opinions.



